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Where to Find the Latest Information

Documentation is updated periodically. For the latest information about these products, including instrument
software upgrades, application information, and product information, browse to one of the following URLs,
according to the name of your product:

http://www.keysight.com/find/m9410a

http://www.keysight.com/find/m9411a

http://www.keysight.com/find/m9415a

To receive the latest updates by email, subscribe to Keysight Email Updates at the following URL:
http://www.keysight.com/find/emailupdates

Information on preventing instrument damage can be found at:

http://www.keysight.com/find/PreventingInstrumentRepair

Is your product software up-to-date?

Periodically, Keysight releases software updates to fix known defects and incorporate product enhancements.
To search for software updates for your product, go to the Keysight Technical Support website at:

http://www.keysight.com/find/techsupport
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Programmer’s Guide

1 Start Programming with [VI Driver

This programmer's guide is intended for individuals who write and run programs to
control test-and-measurement instruments. Specifically, in this programmer's
guide, you will learn how to use Visual Studio 2015 with the .NET Framework to
write Console applications based on IVI.NET driver in Visual C#. Knowledge of
Visual Studio 2015 with the .NET Framework and knowledge of the programming
syntax for Visual C# is required.

KEYSIGHT

TECHNOLOGIES



Start Programming with VI Driver
What You Will Learn In This Guide

What You Will Learn In This Guide
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Our basic user programming model uses the IVI.NET driver directly and allows
customer code to:
Access the IVI.NET driver at the lowest level

Access |Q Acquisition Mode, Power Acquisition Mode, FFT Acquisition
Mode, and Spectrum Acquisition Mode

Control the Keysight M9410A/M9411A/M9415A VXT Vector Transceiver
while performing measurements

Generate waveforms created by Signal Studio software (licenses are
required)

This guide provides the example programs below for your further use with the
VXT transceiver:

Example Program 1: CW Signal Power Test
Example Program 2: Source - Play Waveform
Example Program 3: CW Spectrum Ul

Example Program 4: Channel Power Acquisition
Example Program 5: Spectrum Acquisition
Example Program 6: FFT Acquisition

Example Program 7: 1Q Acquisition

Example Program 8: Power Servo

Example Program 9: Harmonics Test

Example Program 10: ACPR Test

Example Program 11: Combined Power Servo and ACPR Measurement

Programmer’s Guide
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Programmer’s Guide

Start Programming with VI Driver
Related Website

Keysight PXle and AXle Modular Products

Keysight IVI Drivers & Components Downloads
Keysight I/0 Libraries Suite

Keysight GPIB, USB, & Instrument Control Products
Keysight VEE Pro

Keysight Technical Support, Manuals, & Downloads
Contact Keysight

IVl Foundation

MSDN Online

11
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Related Documentation
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To access documentation related to the Keysight M410A/M9411A/M94715A
VXT Vector Transceiver Programmer's Guide, use one of the following
methods:

+ If the product software is installed on your PC, the related documents are
also available in the software installation directory.

Table 1-1 Related Documentation
Document Description Format
Getting Started Includes procedures to help you to unpack, inspect,

install (software and hardware), perform instrument PDF

Guide connections, and troubleshoot your product.

Provides detailed documentation of the IVI.NET and
IVI Driver Reference  IVI-C driver API functions, as well as information to help
(Help System) you get started with using the VI drivers in your
application development environment.

CHM
(Microsoft
Help Format)

X-series Provides basic description about how to program VXT

Applications using SCPI commands, and explains how to use the PDF
Programmer’s Guide  programming documentation.

User’s and CHM
Programmer’s Describes the SCPI commands supported by the VXT (Microsoft
Reference Help Format)

To find the very latest versions of the user documentation, go to the product
website (www.keysight.com/find/vxt) and download the files from the
Manual support page (go to Resource Center > Document Library >
Manuals)

Programmer’s Guide



Start Programming with VI Driver
Overall Process Flow

Overall Process Flow

Programmer’s Guide

Perform the following steps:

1.

Write source code using Microsoft Visual Studio 2015 with .NET Visual C#
running on Windows 10.

Compile source code using the .NET Framework Library.

Produce an Assembly.exe file — you can run this file directly from Microsoft
Windows without any other programs.

When using the Visual Studio Integrated Development Environment
(IDE), the Console Applications you write are stored in conceptual
containers called Solutions and Projects.

You can view and access Solution and Projects using the Solution
Explorer window (View > Solution Explorer).

13
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Preparation Before Programming

Preparation Before Programming

If you want to program VXT module to perform measurement, you need to have
the following hardwares and softwares:

1. VXT M9410A/M9411A/M3415A modular
Chassis (such as Keysight M9018B or M9019A)
Controller (such as Keysight M9037A)
Reference (such as Keysight M9300A)

VXT software

M9300A soft front panel

IO Libraries Suite (Keysight Connection Expert)
Visual Studio (C# or C++ etc) /Labview

© © N o g s~ W N

Window .NET Frameworks Version 4.5.2 or higher version

Hardware Installation

You need install all the listed modules into the chassis as first step of the whole
configuration.

1. Unpack and inspect all hardware.
2. Verify the shipment contents.

3. Install the modules and make cable connections. For detailed procedures,
please refer to M9410A/M3411A/M9I415A Getting Started Guide.

KEYSIGHT  PXle Chassis M3019A Gen 3 High Data Rate Switch Fabric

FRi A @ 0

>

M9037A M9410A/M9411A  M9300A
Controller /M9415A VXT  Reference

14 Programmer’s Guide
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Start Programming with VI Driver
Preparation Before Programming

Connect VXT 100 MHz In port and M9300A 100 MHz Out port with a MMPX
male to BNC male cable, such as Keysight Y1815A.

Software Installation

Programmer’s Guide

You need install the following softwares before programming with VXT:

1.
2.

Install Microsoft Visual Studio with .NET Visual C# running on Windows 7.

Install Keysight 10 Libraries Suite, this installation includes Keysight
Connection Expert.

Install the VXT software, Version 16.57 or newer. Driver software includes
all IVI.NET and IVI-C Drivers and documentation. All of these items may be
downloaded from the Keysight VXT product website.

Install the VXT licenses, if you purchased. Please refer to VXT Getting
Started Guide for further information.

Install the M9300A software. Please refer to M9300A Startup Guide for
further information.

The M9300A PXle Reference must be included as part of the M941xA
configurations. The M9300A PXle Reference must be initialized first so that
the other configurations that depend on the reference signal get the signal
they are expecting. If the configuration of modules that is initialized first
does not include the M3300A PXle Reference, unlock errors will occur.

Once the software and hardware are installed and Self-Test has been
performed, they are ready to be programmatically controlled.

15
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Function Verification

Function Verification

To make sure all the hardwares and softwares are ready for your programming,
please perform the following steps to generate a CW signal with VXT:

1. Connect VXT RF Output and RF Input with a SMA cable.

o (®
KEYSIGHT Ms9410A

VXT Vector Transceiver 1MHz-6 GHz

16 Programmer’s Guide



Start Programming with VI Driver
Function Verification

2. Power on the chassis and run M9300A software. The software window will
be pop up as below. The icon "Int Ref Locked" on the lower left corner
indicates the software runs properly.

E Keysight M9300A PXIe Frequency Reference

File View Utilities Tools Help

~100 MHz Reference ~Other References

Out 1 Enabled [ ] 100 MHz BP Out Enabled
Out 2 Enabled 10 MHz Out Enabled
out 3 Enabled [] ocxo out Enabled

Out 4 Enabled
Out 5 Enabled

~External Reference

[] use External Reference
Frequency: 110 MHz ]

Measured Frequency: 0 MHz

Int Ref
Locked

Connected: PXI13::0::0::INSTR |rfj‘_| Mo Error

3. Run VXT software by click LaunchModularTRX.exe. Please refer to VXT
Getting Started Guide for the detailed procedure.

4. Set VXT source to generate a CW signal and use VXT receiver to observe
this signal.

1. Press Frequency > Input/Output > Source Amplitude > - 20 dBm to set
the signal amplitude to -20 dBm

2. Press Frequency > 1 GHz to set the signal frequency to T GHz.

3. Press RF Output On to turn on the source output

Programmer’s Guide 17



Start Programming with VI Driver

Function Verification

4. Press Input/Output > Frequency > Center Freq > 1 GHz to set the receiver

1Q Analyzer 1
Complex Spectrum |t

KEYSIGHT [Input: RF Input
Coupling: AC

1 Spectrum
Scale/Div 10.00 dB

2 Ia Waveform
Scale/Div 100.0 mV

0.000 s
Digital IF BW 8.0000 MHz

#9~ M ?

Mov 15, 2018 L]
4:27:44 P

center frequency to 1 GHz.

Center Freqg: 1.000000000 GHz
Avg Type: Log-Pwr Avg
Avg|Hold=25/25

Input Z: 50 Q [Range: 0 dBm [Trig: Free Run
Corrections: Off

Freq Ref: External

Ref Value 0.00 dBm

Ref Value 0.0 V

23.556 us
Acq Time 23.556 ps (237 pts)
LV
- LAY

Scale/Div 2.356 ps

If you observe the CW signal as figure above, it indicates the VXT is ready for
your programming, VXT supports multiple programming platform, such as
Visual C#, Visual Basic .Net, Visual C++, Keysight VEE pro, Labview and
MATLAB. In this guide, all the programming examples are programmed with
Visual C#.

18
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Keysight VXT Vector Transceiver
M9410A, MI4T1A, MI415A

Programmer’s Guide

APIls Introduction

This chapter describes the Application Programming Interfaces (APIs) for the
Keysight VXT vector transceiver.

The following IVI driver terminology may be used when describing the Application
Programming Interfaces (APIs) for the VXT Vector Transceiver.

IVI[Interchangeable Virtual Instruments] - a standard instrument driver model
defined by the IVI Foundation that enables engineers to exchange instruments
made by different manufacturers without rewriting their code.

Currently, there are 13 IVI Instrument Classes defined by the VI Foundation. The
VXT Vector Transceiver do not belong to any of these 13 IVI Instrument Classes
and are therefore described as "NoClass" modules.

DC Power Supply
AC Power Supply
DMM

Function Generator
Oscilloscope
Power Meter

RF Signal Generator
Spectrum Analyzer
Upconverter
Downconverter
Digitizer

Counter/Timer

KEYSIGHT

TECHNOLOGIES
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APIs Introduction
IVI Compliant or IVI Class Compliant

IVI Compliant or VI Class Compliant

The VXT Vector Transceiver is IVI Compliant, but not IVI Class Compliant; none
of these belongs to one of the 13 IVI Instrument Classes defined by the VI
Foundation.

IVI Compliant - means that the IVI driver follows architectural specification
for these categories:

— Installation

— Inherent Capabilities

— Cross Class Capabilities
— Custom Instrument API

IVI Class Compliant - means that the IVI driver follows architectural
specification for these categories:

— Ifaninstrument is IVI Class Compliant, it is also IVl compliant

— Provides one of the 13 IVI Instrument Class APIs is in addtion to a
Custom API

— Custom API may be omitted (unusual)

— Simplifies exchanging instruments

20 Programmer’s Guide



APIs Introduction
IVI Driver Types

IVI Driver Types

Figure 2-1

Programmer’s Guide

There are several types of VI drivers as listed below:

IVI Driver Types

IVI Driver

IVI Specific

Driver
MO39 1A PXle VSA
and M938xA PXla V56

Vi Class

Driver

13 1V Instrument
(lasses defined by
the 1Vl Foundation:

- DC Poswner Supply
- AL Poweer Supply
- DKM
- Function Generator
- Oscilloscope

Ponwisr Mieter
- RF Signal Generator
- Bpectrem Analy zer
- Switch
- Upronwerter

D A onsirer
- Digitizer
Counter/Tmer

IV Class-Compliant
Specific Driver

IVl Custom
Specific Driver
[REEEATY

VI Driver

Implements the Inherent Capabilities Specification

Complies with all of the architecture specifications

May or may not comply with one of the 13 VI Instrument Classes

Is either an IVI Specific Driver or an IVI Class Driver

IVI Class Driver

— Isan VI Driver needed only for interchangeability in IVI-C environments
— The IVI Class may be IVI-defined or customer-defined

IVl Specific Driver

— Isan VI Driver needed only for interchangeability in IVI-C environments
— The IVI Class may be IVI-defined or customer-defined

IVI Class-Compliant Specific Driver

— VI Specific Driver that complies with one (or more) of the VI defined
class specifications

— Used when hardware independence is desired

21



APIs Introduction
IVI Driver Types

IVI Custom Specific Driver

— Is an VI Specific Driver that is not compliant with any one of the 13 VI
defined class specifications

— Used when hardware independence is desired

This release is not binary compatible with prior releases of the IVI-C driver.
Programs using the C/C++ IVI-C driver must be recompiled for this version of the
driver. Similarly, programs compiled with this version of the driver will not be
compatible with older versions of the IVI-C driver. This incompatibility is due to
renumbering of attribute constants defined in the KtM341x.h include file.

22 Programmer’s Guide



APIs Introduction
IVI Driver Hierarchy

IVI Driver Hierarchy

Programmer’s Guide

When writing programs, you will be using the interfaces (APIs) available to the
IVI.NET driver.

The core of every IVI.NET driver is a single object with many interfaces.

These interfaces are organized into two hierarchies: Class-Compliant
Hierarchy and Instrument-Specific Hierarchy — and both include the
llviDriver interfaces.

— Class-Compliant Hierarchy - Since the VXT Vector Transceiver does not
belong to one of the 13 IVI Classes, there is noClass-Compliant
Hierarchy in their VI Driver.

— Instrument-Specific Hierarchy

— The VXT Vector Transceiver’s instrument-specific hierarchy has
IKtM9410 at the root (where KtM9410 is the driver name).

— |IKtM9410 is the root interface and contains references to child
interface, which in turn contain references to other child
interfaces. Collectively, these interfaces define the
Instrument-Specific Hierarchy.

— The IlviDriver interfaces are incorporated into both hierarchies: Class-
Compliant Hierarchy and Instrument-Specific Hierarchy.

The llviDriver is the root interface for VI Inherent Capabilities which are
what the IVI Foundation has established ass a set of functions and
attributes that all IVI drivers must include - irrespective of which IVI
instrument class the driver supports. These common functions and
attributes are called IVl inherent capabilities and they are documented in
IVI-3.2 -Inherent Capabilities Specification. Drivers that do not support
any IVl instrument class such as the VXT Vector Transceiver must still
include these VI inherent capabilities.

Close
DriverOperation
|dentity
Initialized
Utility

23
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Instrument-Specific Hierarchies for VXT

Instrument-Specific Hierarchies for VXT

Figure 2-2

24

Keysight VXT Instrument-Specific Hierarchy

KtM941x is the driver name

IKtM941x is the root interface

Keysight VXT Instrument-Specific Hierarchy

@ Calibration
G- Clock Alignment
@ DeviceSync
@ DriverDperation
@ FpoaSandbouxs
-8 Hyi

- Identity

@ Measuremert
G- Modules
- Odi

@ Other

@ PeerToPeerPorts
- Receiver
@ Source

@ Status

@ StreamReaders
-8 StreamWriters
@ System

-8 Lkility

- Waveforms

The following table lists the instrument-specific hierarchy interfaces for
M941XA VXT Vector Transceiver.

All new code being created should use the IKtM341x extended interfaces in
place of the IKtM9410 interfaces. New functionalities have been added to the
IKtM941x extended interfaces. These new functionalities were not available in the
original IKtM9410 interfaces, and have been left unchanged to support previously
written code; this helps support backward code compatibility.

Programmer’s Guide



When Using Visual Studio

To view interfaces available in VXT, click KtM341x library file, in the References
folder, from the Solution Explorer window and select View in Object Browser.

Figure 2-3

Programmer’s Guide

APIs Introduction
Instrument-Specific Hierarchies for VXT

Keysight VXT Instrument-Specific Hierarchy
[ o0 Ivi.Driver
4 w0 Eeysight.Kihd941: Fads
iz Agiizaldl?

2
k
2
k
P
2
k
2

{}
{}
{}
{}
{}
{}

AgifisaddwviBventHandler
Keysight.ApiCarelibraries
Keysight.kihd41x
Keysight.kth1941x.Bridge
Keywsight.bthd 94 1B
Keysight.Moduladnstruments
MindWarks.Mimbus

[ =B Microsoft. Ciharp

4 u-B References
& Analyzers
u-0 Tvi.Driver
50 Keysight KthA941: Fxd5
5B Microsoft.CSharp
5B System
-0 Systern, Core
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Naming Conventions Used to Program IVI Drivers

Naming Conventions Used to Program IVI Drivers

General IVI Naming Conventions

All instrument class names start with "IVi"
Example: IviScope, IviDmm

Function names

One or more words use PascalCasing

First word should be a verb

IVILNET Naming Conventions

Interface naming

Class compliant: Starts with "[lvi"
I<ClassNaming>
Example:llviScope, llviDmm

Sub-interfaces add words to the base name that match the C hierarchy as
close as possible

Example: llviFgenArbitrary, llviFgenArbitraryWaveform
Enum values don’t end in "Enum" but use the last word to differentiate

Example: IviScopeTriggerCouplingAC AND
IviScopeTriggercouplingDC

26 Programmer’s Guide
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Programmer’s Guide

3  Creating a Project with IVI.NET Using C#

What you will learn in this chapter

This tutorial will walk through the various examples to create a console
applications using Visual Studio and C#. It demonstrates how to instantiate driver
instance, set the resource names and various initialization values, initialize the
driver instance, print various driver properties to a console for each driver
instance, check drivers for errors and report the errors if any occur, and close both
drivers.

The project examples are listed below.
1. CW Signal Power Test

Source - Play Waveform

Start X Application

Channel Power Acquisition
Spectrum Acquisition

FFT Acquisition

IQ Acquisition

© N o g s W N

Power Servo Measurement
9. Harmonics Measurement
10. ACPR Measurement

11. Combined Power Servo and ACPR Measurement

All the example programs above are in the folder below after the VXT software is
installed.

C:\Program Files\IVI Foundation\IV\Microsoft. NET\Framework64\v4.5.50709\
Keysight. KtM94Tx x.x.x\Examples\CSharp

KEYSIGHT

TECHNOLOGIES
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Creating a Project with IVI.NET Using C#
Example 1: CW Signal Power Test

Example T: CW Signal Power Test

Figure 3-1

28

This example introduces the programming procedure to perform a CW signal
power test as below with VXT using Visual Studio and C#.

VXT source outputs a T GHz CW signal

VXT receiver measures this signal power

VXT CW Signal Power Test Cable Connection

& W

KEYSIGHT Mo410A

VXT Vector Transceiver 1MHz-6 GHz

aaaaa

Before programming, please connect VXT RF Output to RF Input port.

The programming procedure are listed as 8 steps as below:

Step 1. - Create a "Console Application”

Step 2. - Add References

Step 3. - Add Using Statements

Step 4. - Create an Instance

Step 5. - Initialize the Instance

Step 6. - Write the Program (Create a Signal or Perform a Measurement)
Step 7. - Close the Instance

Step 8. - Build and Run the Program

After the VXT software is installed, you will find the source code as below:

C:\Program Files\IVI Foundation\IVAMicrosoft. NET\Framework64\v4.5.50709\
Keysight.KtM941x x.x.x\Examples\CSharp\CsCWPowerTest.

Programmer’s Guide



A Azzemblies

Frarmewvork
Extenzions
Recent

P Projects
P Shared Projects
BCOmM

[+ Browese
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Creating a Project with IVI.NET Using C#
Example 1: CW Signal Power Test

Step 1 - Create a Console Application

1. Launch Visual Studio and create a new Console Application in Visual C# by
selecting: File > New > Project and select a Visual C# Console Application.

2. Enter "CWPowerTest" as the Name of the project and click OK.

Step 2 - Add References

In order to access the VXT driver interfaces, references to their drivers (DLL)

must be created.

1. In Solution Explorer, right-click on References and select Add Reference.

Solution Explorer
ME- ©-5¢Tm K=
Search Solution Explorer (Ctrl+) 2~

fad Solution 'CS_CWPowerTest' (1 project)
A C5_CWPowerTest
P Properties

'f'j app.c Add Reference..,
P o Prog Add Service Reference..,
25 Add Connected Service

2. From the Reference Manager, select the Assemblies table to find VXT's
driver - Keysight.KtM941x. Take note there are two Keysight.KtM941X
drivers in the list, one for 64 bits system and the other for X86 system.
Choose the 64 bits driver, then press OK to confirm. The 64 bits driver is in
C:\Program Files\, while the 32 bits one is in C:\Program Files (x86)\.

Beference Manager - 5 CWPowerTest

Targeting: .MET Framewaork 4.5.2

Marne
Kewsight.Krnf Hardware Measurements.Scp

Kewsight.Kimf Hardware. beasurements Orfs
Kewsight.Krnf Hardware Measurernents P ower

Kewsight.Kmf Hardware Measurements. Sem

keysight Krmf.I0Mavefarm
Keywsight.Krnf Reactive
Keysight.Kimf. Samples. ULCammaon
Kewsight.KtCornerstane

kewsight, Kiha941:
Kewsight KihA94 1

keysight.Krmf Hardware Measurerments. Chann,.,
Keywsight.Krnf Hardware Measurements.MoiseF..,

keysight.Krmf Hardware Measurements Power..,

Kewsight.Krnf Hardware Measurements Wavef..,

Wersion
1.14.130.0
1.14.130.0
1.14.130.0
1.14.130.0
1.14.130.0
1.14.130.0
1.14.130.0
1.14.130.0
1.14.130.0
1.14.130.0
1.14.130.0
0.2.0.0
0.2.0.0
0.3.2340.0
1.3.2340.0

|

Mame:
ACE2-Publi
Created by:
Kewsight Te
Yersion:
1.0.0.0

File Yersion
1.0.0.0

Ke Marne: Keysight KEh941:

Wersion: 0,3.2340.0
File Wersion: 0.3.2340.0

R

Path: CAProgram Files'IWI Foundation\TWicrosoft MET Frameworkd 444,55
\Keysight.RtEﬁﬁEE.szs all
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If you have not installed the IVI driver for the VXT product (as listed in
chapter 1, Before Programming, Install Hardware, Software, and Software
Licenses), the IVI drivers will not appear in this list.

3. Select the IVI Driver Assembly 1.4.0.0 or higher version, and press OK to
confirm. There are two VI Driver assembly file for each version, one is for 64
bits system and another is for X86 system. Confirm the version via the file
path from the address in the figure below.

Reference Manager - C5_CWYPowerTest

4 Assemblies

Frarmewark
Extensions
Recent

P Projects
P Shared Projects
b CORM

B Browse

30

Targeting: .MET Frarmework 4.5.2 Search (Ctrl+E)
Marne Wersion “ Mame:
I Dmim Assernbly 14.0.0 VT Driver Sssembly
LT Dioevniconwverter Sssermbly L3.0.0 Created by:
VT Donvniconverter &ssembly 1.3.0.0 MW Foundation
[T Diowvniconwverter Sssermbly 14.0.0 Version:
VI Dowvncorverker &ssembly 1.4.0.0 1.4.0.0
bly 1.3.0.0 File Yersion:
h 1.3.0.0 1.41621.1

1.4.0.0
1.4 (1.0

W Drrver Asserm bl
IV Fgen Assemb| Mame: VI Driver fssermbly

VI Fgen Lssemb Path: c:\Program Files\VI Foundation\IvIyMicros oft. METVFramework £ 442
IVIFgen Assemb “wiFoundationsharedCormponents 1.4, 10\ Driver.dll

Wersion: 1.4.0.0
I Fgen Assernb| © .
el fsse File Wersion: 1.4.1621.1

4. Now the IVI drivers are referenced and available for your use.
M Properties

4 O] References
& Analyzers

=B Tvi.Driver

u-0 Keysight KA 943w Fud
=B PAicrozoft,.CEharp

=B Spstern

u-B Spstern,Core

Step 3 - Add Using Statements

To allow your program to access the VI drivers without specifying full path
names of each interface or enum, you need to add using statements to your
program.

All data types (interfaces and enums) are contained within namespaces. (A
namespace is a hierarchical naming scheme for grouping types into logical
categories of related functionality. Design tools, such as Visual Studio, can use
namespaces which makes it easier to browse and reference types in your
code.)The C# using statement allows the type name to be used directly.
Without the using statement, the complete namespace-qualified name must
be used. To allow your program to access the IVI driver without having to type
the full path of each interface or enum, type the following using statements
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immediately below the other using statements.

11 —lusing System;

12

13 I using Keysigh‘t.K‘tMlex;l

14

15 -lnamespace C5_ CWPowerTest

16 {

17 - /// Keysight VXTII M941xA Driwve

Step 4 - Create and Initialize the Driver Instances

There are two ways to instantiate (create an instance of) the IVI.NET drivers:
Direct Instantiation
COM Session Factory

Since the VXT vector transceiver is considered NoClass module (because they
do not belong to one of the 13 IVI Classes), the COM Session Factory is not
used to create instances of their IVI.NET drivers. So, VXT vector transceiver
IVI.NET driver uses direct instantiation. Because direct instantiation is used,
their IVLLNET drivers may not be interchangeable with other modules.

To create driver instances, the new operator is used in C# as below.
IKtM941x Driver = new KtM941x();

The Initialize() method is required when using any IVI driver. It establishes
a communication link (an "I/0 session") with an instrument and it must be
called before the program can do anything with an instrument or work in
simulation mode.

The Initialize() method has a number of options that can be defined. In this
example, we prepare the Initialize() method by defining only a few of the
parameters, then we call the Initialize() method with the parameters
below.

To initialize the driver instances, the example code below is used in C#.
KtM941x driver = null;

string ResourceName = "PXI21::0::0::INSTR";

bool IdQuery = true;

bool Reset = true;

string OptionString = "QueryInstrStatus=true, Simulate=false,
DriverSetup= Model=M941xA";

driver = new KtM941x(ResourceName, IdQuery, Reset, OptionString);
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Initialize Parameters

The following tables describes options that are most commonly used to
initialize the instance.

Property Type and
Example Value

string ResourceName
= "PX113::0::0:INSTR";

Description of Property

VxtResourceName - The driver is typically initialized using a physical resource name
descriptor, often a VISA resource descriptor. See the procedure in the Resource Names
section in the next page.

bool IdQuery = true;

Setting the ID query to false prevents the driver from verifying that the connected
instrument is the one the driver was written for because if [dQuery is set to true, this will
query the instrument model and fail initialization if the model is not supported by the
driver.

bool Reset = true;

Setting Reset to true instructs the driver to initially reset the instrument.

string OptionString =
"QuerylnstrStatus=true,

OptionString - Setup the following initialization options:

Simulate=true,

QuerylInstrStatus=true (Specifies whether the IVI specific driver queries the
instrumetn status at the end of each user operation.)

Simulate=true (Setting Simulate to true instructs the driver to not to attempt to
connect to a physical instrument, but use a simulation of the instrument instead.)

Cache=false (Specifies whether or not to cache the value of properties.)
InterchangeCheck=false (Specifies whether the IVI specific driver performs
interchangeability checking.)

RangeCheck=false (Specifies whether the IVI specific driver validates attribute values
and function parameters.)

RecordCoercions=false (Specifies whether the IVI specific driver keeps a list of the
value coercions it makes for Vilnt32 and ViReal64 attributes.)

DriverSetup=";

DriverSetup= (This is used to specify settings that are supported by the driver, but
not defined by IVI. If the Options String parameter (OptionString in this example)
contains an assignment for the Driver Setup attribute, the Initialize function assumes
that everything following 'DriverSetup="is part of the assignment.)

Resource Names

You need to determine the Resource Name address string (VISA address string)
that is needed.

Run VXT software (LaunchModularTRX.exe). The VXT modular’ VISA
address is listed in the software window as below.

m Launch Modular TRX
Madules
Selected  Slot Number Madel VISA Address Status

[ 15 MS4104 | PXI21:0:0:INSTR Idle

Please refer to VXT IVI Driver Help (Start > All programs > Keysight Instrument
Drivers > IVI.NET Drivers > KtM941x > KtM941x IVI Driver Help) as below for further
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information.

| Keysight Instrument Drivers
'| Keysight Driver Downloads
IVI-COM-C Drivers
| AgXSAn Spectrum Analyzer
I AgXSAnBasic Spectrum Analyz
| AgXSANWLAN Spectrum Analy
| KtM9420
™| KtM9420 Introduction
. KtM9420 IVI Driver Help
KtM9420 Readme

111

Step b5 - Write the Program

At this point, you can add program steps that use the driver instances to
perform tasks.In this example, perform the following steps:

1. Set VXT source to generate a -10 dBm CW signal at 1 GHz.

2. Set VXT receiver to measure the power of the CW signal.

Set the VXT Source

To set the VXT source to generate a -10 dBm CW signal at T GHz, please refer
to the example code as below:

driver.Source.RF.Frequency = 1e9;

//Set the source's center frequency.

driver.Source.RF.Level = -10;

//Set the source's RF power level.

driver.Source.RF.OutputPort = Port.RFOutput;//Select source output port
//Select the source output port

driver.Source.RF.OutputEnable = true;

//Enable output.
driver.Apply();

//Apply the above setting to VXT source's hardware.

For more APIs about VXT source frequency settings, please refer to the VXT IVI
driver help as below.
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Set the VXT Receiver

To measure the channel power in a bandwidth, please refer to the example
code below:

driver.Receiver.RF.Frequency = 1e9; //Set Receiver's Center Freq
driver.Receiver.RF.Power = -5;

//the Receiver.RF.Power should be set equal to or little bigger than target
test value, to get exact test result

driver.Receiver.RF.PeakerToAverage = 3;

//Set Receiver's Peak to Average value. It's a important setting for digital
modulation signal test.

driver.Receiver.RF.InputPort = Port.RFInput;//Set the RF input port
driver.Receiver.AcquisitionMode = AcquisitionMode.Power; //Choose Power
Acquisition Mode.

driver.PowerAcquisition.Bandwidth = 1e6;
driver.PowerAcquisition.Duration = 0.02;
driver.Receiver.PowerAcquisition.ChannelFilter.Shape =
ChannelFilterShape.None;

driver.PowerAcquisition.ChannelFilter.Alpha = 0.5;
driver.PowerAcquisition.ChannelFilter.Bandwidth = 1e5;//Set the channel
bandwidth.

driver.Apply();//Apply the above setting to VXT receiver's hardware.
driver.Arm();//Start the M941xA's receiver's measurement

driver.Receiver.PowerAcquisition.ReadPower (CAPTURE_ID, PowerUnits.dBm, out
power, out overloaded); //Read the power measurement result.

For more example codes of frequently used measurement cases, please refer to
the other examples introduced in this chapter.

Step 6 - Close the Driver

Calling Close() at the end of the program is required by the IVI specification
when using any VI driver.

driver.Close();

Close() may be the most commonly missed step when using an IVI driver.
Failing to do this could mean that system resources are not freed up and your
program may behave unexpectedly on subsequent executions.
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Step /7 - Build and Run a Complete Program
Build your console application and run it to verify it works properly.

1. Open the solution file CWSignalTest.sln in Visual Studio.

2. Setthe appropriate platform target. If the installed VXT software is 64-bit,

you need to set the active solution platform as X64 in configuration
manager.

Debug  Tearm  Tools  Test  Analyze Y
Debug - |=64 b Sta

xhd =

I Configuration Manager... IE

y

Configuration Manager ¥
Active solution configuration: Active solution platform:
| |Debug v | |x64
Project contexts (check the project configurations to build or deploy):
Project Configuration Platform Build
[CS_CWsSignalTest_withoutULwithRef | Debug | x64 - (v
| ) - :

Programmer’s Guide

3. Choose Project > CWSignalTest Properties and select Build/Rebuild
Solution. And the program file will be built out.

4. Run the program and you will get the test result as below.

CS_CUWPowerTest
Current SPI Config Ualue = BxBDriver Initialized

UXTII M?418A Successfully Generated 1 GHz -18 dBm CUW Signal.
CY Signal'Power = —-9.13169147837215

If want to measure again. please press Enter button.
If Quit, please enter stop.

Before running the program, please make sure the M9300A reference
software is turned on.

It will take several minutes to run the program as the VXT vector transceiver

need boot up before running this program.

For the most of the VXT programs, the step 1, 2, 3, 6, 7 are same. The only
difference is in step 4, b, you need program your own code.

From the example 2 to 10, we will just focus on step 5 - Write the Program.
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Example 2: Source - Generate LTE FDD Signal

This example introduces the programming procedure to output a LTE FDD
signal with M3410A/M9411A/M9415A source using Visual Studio and C#.

N7624B Signal Studio for LTE/LTE-FDD is needed to play a LTE FDD signal
NOTE with VXT product.
Figure 3-2 VXT Source Play Waveform Cable Connection

ssssss

Connect RF
Output to
Spectrum
Analyzer

sssss

.....

Before programming, please connect VXT 100 MHz Ref In port to M9300A’s
100 MHz Ref Out port.

The programming procedure are listed as 8 steps as below:
Step 1. - Create your project with Visual C#

Step 2. - Add References

Step 3. - Add Using Statements

Step 4. - Create and Initialize the Instance

Step 5. - Write the Program (Generate a LTE FDD signal with M941xA source)
Step 6. - Close the Instance
Step 7. - Build and Run the Program

Forstep 1, 2, 3, 4, 6, 7, pleas refer to example 1 as those steps are similar. This
section will only introduce the example code for step b.

After the VXT software is installed, you will find the source code as below:

C:\Program Files\IVI Foundation\IVA\Microsoft. NET\Framework64\v4.5.50709\
Keysight. KtM341x x.x.x\Examples\CSharp\CsSource_Play_Waveform.
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Write the Measurement Program

To output a LTE FDD signal with M9410A/M9411A/M9415A source, please
refer to the example code as below:

string filePath = "C:\\Waveform";
string fileName = "LTE_UL_FDD_RMC_5MHz_16QAM.wfm";
driver.Source.LoadWaveform(filePath, fileName); //load the wave form

driver.Source.RF.Frequency = 1e9;//Set the source center frequency. In this
code it's set to 1le9Hz.

driver.Source.RF.Level = -5; //Set the source's RF power level.
driver.Source.RF.OutputPort = Port.RFOutput; //Select source output port
driver.Source.RF.OutputEnabled = true; //Enable output.
driver.Source.Modulation.PlayArb(fileName, startEvent: StartEvent.Immediate);
driver.Source.Modulation.Enabled = true;

driver.Apply(); //Apply the above setting to VXT source's hardware.

The waveform file “LTE_UL_FDD_RMC_5MHz_16QAM.wfm” used in this example code
is attached in the project file.

Formal Example Code » CS_Source Play_Waveform »

HE~ it
‘ #ER

I bin

I obj

I Properties

d CS_Source_Play_Waveform.csproj

0 CS_Source_Play_Waveform.sin
CS_Source_Play_Waveform.sin.docstates.suo
CS_Source_Play_Waveform.suo
LTE_UL_FDD_RMC_5MHz_16QAM.wfm

c’_]Program.cs

m

Commands Summary

Driver.Apply() method is used to update all the parameter setting, for
VXT source and receiver. It is a frequently used method.

The methods of Driver.Source.RF are used to set the basic RF
parameters, such as output signal freq, level, output port. If you don’t play
any waveform, it will generate a CW signal as example 1 does.
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Driver.Source.LoadWaveform() is used to load waveform to VXT

memory, It allows you to load multiple waveform files into memory at the
same time.

Driver.Source.Modulation.PlayArb is used to choose the waveform to

play. VXT supports loading multiple waveform into memory as generating
digital demodulation signal.

Get the Measurement Result

Refer to the process of step 7 in example 1 to build and run your program to
get the result as below.

Generate a LTE 5 MHz Uplink Signal with Keysight UXTII H?41ixh
Current SPI Config Value : BxBDriver Initialized

Load waveform: LTE_UL_FDD_RMC_SHHz_16QAM.uwfm
UXTII M?41ixhA Successfully Generated Signal.

0. 00dBm
il g M lllh"'| h lhﬁ I |{"ﬂ"|~ ity
’w[ ¥ ||| 'u ! 'JM\Ir | Hljlp M |“Ir|||!||\|'|| ’

F3

FFT ;

!
A Ai | ‘|||
g rg "|||'f I|| r‘iﬂ‘.f hllu' I ||||

Center Freg
1 G

It will take several minutes to run the program as the VXT vector transceiver
need boot up before running this program.
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Example 3: Start a X-Series Application Display

Figure 3-3

NOTE

Programmer’s Guide

This example introduces the programming procedure to display a spectrum in
X series spectrum Ul with MO4TxA.

VXT source outputs a T GHz CW signal

Turn on the X series spectrum analyzer application display and use SCP!I
command to set the receiver display the spectrum

Example 3 - Cable Connection

Connect
RF Out
toRF In

Before programming, please connect VXT RF Output to RF Input port and
VXT 100 MHz Ref In port to M9300A’s 100 MHz Ref Out port.

The programming procedure are listed as 8 steps as below:

Step 1. - Create your project with Visual C#

Step 2. - Add references

Step 3. - Add using statements

Step 4. - Create and initialize the Instance

Step 5. - Set source to generate CW signal

Step 6. - Setup SCPI programming environment

Step 7. - Set receiver to observe the CW signal with X-series spectrum Ul
Step 8. - Close the Instance

Step 9. - Build and Run the Program

Forstep 1, 2, 3, 4,5, 8, 9, pleas refer to example 1 as those steps are similar.
This section will only introduce the example code for step 6 and 7.

After the VXT software is installed, you will find the source code as below:

C:\Program Files\IVI Foundation\IVA\Microsoft. NET\Framework64\v4.5.50709\
Keysight. KtM34Tx x.x.x\Examples\CSharp\CsStart_X_APP.
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Initialize Instance and Turn on Application Ul

To initialize the driver instance and turn on Application Ul, please refer to the
example code as below:

string ResourceName = "PXI0::21-0.0::INSTR";

bool IdQuery = true;

bool Reset = true;

string OptionString = "QueryInstrStatus=true, Simulate=false, DriverSetup=
Model=M941xA, TouchGuiStart=true";

driver = new KtM941x(ResourceName, IdQuery, Reset, OptionString);

AppStart=true is used to turn on the VXT application Ul display. If you do not
need the Ul display, just delete the AppStart = true from the Option String.

Setup SCPI Programming Environment

To setup SCPI programming environment, please refer to the procedure below:

1.
2.

Install Keysight IO Libraries Suite.

Add file "agvisa32.cs" into your project. Select Add > Existing Item in Visual
Studio as below. The file "agvisa32.cs" is located at
C:\Program Files (x86)\IVI Foundation\VISA\WinNT\agvisa\include

5] €S_CW_Spectrum_UI

(£ Build =4 Properties
Rebuild -] References
Clean 4] agvisa32.cs
“ Publish... ] Program.cs
Add » | 5] NewItem... Ctrl+Shift+A
Add Reference... 2l Existing Item... Shift+Alt+A

Add the code below to your project to enable VISA connection with X series
application.

int rm = @; int xApp;

AgVisa32.viOpenDefaultRM(out rm);

AgVisa32.viOpen(rm, “TCPIPO::localhost::hislip3::INSTR”, @, 0, out xApp);
AgVisa32.viSetAttribute(xApp, AgVisa32.VI_ATTR_TMO_VALUE, 100090);
AgVisa32.viPrintf(xApp, ":SYST:ERR:VERB ON;\n"); //clear the system error

information

The VISA connection needs hislip LAN address. The
"TCPIPQ::localhost::hislip3::INSTR" used in viOpen method is a hislip
address. Please run LaunchModularTRX.exe to get the hislip address as
below.

34104 PRIZ1:020:INSTR  Idle

=N OB =3
lodel WISA Address  Status Associated Modul Combined Model Serial Mumber GUI Type Launch Type  Telnet Port Socket Port  Physics Port HiSLIP Dev
Configure --- MY00000015  MultiTouch 'i Auto = 5323 5325 3577 3 E:

E| [Module Licenses| [Update FPGA| lHide Advanced Setting5| |
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Set Receiver to Observe Signal

To set VXT receiver to observe the CW signal, please refer to the example code
as below:
AgVisa32.viPrintf(xApp, ":INST:SEL BASIC;\n");//Enter basic mode (IQ Analyzer)

//It will take several seconds to load or switch mode, so this below code to
wait and check.

int tryTimes = 0; string queryResult;

do

{

AgVisa32.viPrintf(xApp, ":INST:SEL? \n");

AgVisa32.viRead(xApp, out queryResult, 1024);

tryTimes++;

}
while ((queryResult != "BASIC\n") && (tryTimes < 100));

AgVisa32.viPrintf(xApp, ":FREQ:CENT 1e9 Hz \n");//Set Frequency
AgVisa32.viPrintf(xApp, "INIT:CONT 1 \n"); //Set continuous sweep mode
AgVisa32.viPrintf(xApp, ":POW:RANG 10.0 \n");//Set Attenuator

Get the Measurement Result

Refer to the process of step 7 in example 1 to build and run your program to
get the result as below.

B Keysight M94104 - Chassis1 - Slotl5 - 1Q Analyzer - Complex Spectrum o)==
R T RFE S0Q  AC [ EXT REF| [ 01:34:23 PMMov 21, 2018 F
Center Freq 1.000000000 GHz Center Freq: 1.000000000 GHz [EqLency
] Trig: Free Run Avg|Hold:>25125

Range: 0 dBm

Ref 0dBm

CenterFreq
1.000000000 GHz

Center 1.000000 GHz Span 8.000 MHz

Digital IF BW 8.0000 MHz Capture Time

MSG STATUS

It will take several minutes to run the program as the VXT vector transceiver
need boot up before running this program.
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Basic Concepts: Two VXT Control Method

The VXT supports two method for remote control: by IVI driver and by SCPI
command. The example 1 and 2 use IVI driver method and example 3 uses
both methods.

IVI driver provides fast measurement speed and support power servo
measurement with VXT.

SCPI command programming provides more features and Keysight classic Ul

display.
Figure 3-4 IVI driver and SCPI driver in VXT
Customer Code
VI Driver for direct SCPI Driver for
control of hardware Application control
X-Apps
For Power servo Aoplicati
and Fast power Container
—_——

Share Physics interface

—_ i driver l

| M9410A/MI411A/MI4T5A |

The table below shows the supported measurement and features by VI driver

and SCPI.

Features IVI Driver SCPI
Spectrum Analysis Supported Supported
FFT Analysis Supported Supported
IQ Data Acquisition Supported Supported
Channel Power Test Supported Supported
Power Servo Supported Not supported
ACPR Supported Supported
Harmonics Supported Supported
OBW Not supported Supported
Spectrum Emission Mask Not supported Supported
Marker Not supported Supported
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Features IVI Driver SCPI

Source (digital signal)’ Supported Supported
Demod Digital Signal (EVM result) Not supported Supported
Keysight Classic Spectrum Ul Not supported Supported

* The VXT plays waveform file to produce digital signal.

SCPI Commands Control Method

There are two steps to use SCPI control method:

1. Setup VISA connection between PC and instrument
2. Send instrument SCPI command.

For example, Agvisa32.viPrintf(xApp, ":FREQ:CENT 1e9 Hz\n");//Set
receiver’s Center Freq isacommand used in example 3. :FREQ:CENT 1e9 Hz
is a SCPI command.

To get a SCPI command, please refer to the online help system in VXT software
or download the corresponding mode’s User’s and Programmer’s Reference
from http://keysight.com/find/m9410a

For further information about SCPI command programming, please refer to
X-Series Programmer’s Guide.
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Example 4: Channel Power Acquisition

NOTE

44

This example introduces the programming procedure to measure signal
channel power with VXT.

VXT source outputs a LTE FDD signal

VXT receiver measures the signal channel power

N7624B Signal Studio for LTE/LTE-FDD is needed to play a LTE FDD signal
with VXT product.

Before programming, please connect VXT RF Output to RF Input port and VXT
100 MHz Ref In port to M9300A’s 100 MHz Ref Out port. Please refer to Figure
3-1 for details.

The programming procedure are listed as 8 steps as below:
Step 1. - Create your project with Visual C#

Step 2. - Add References

Step 3. - Add Using Statements

Step 4. - Create and initialize the Instance

Step b. - Write the Program

Step 6. - Close the Instance

Step 7. - Build and Run the Program

Forstep 1, 2, 3, 4, 6, 7, pleas refer to example 1 as those steps are similar. This
section will only introduce the example code for step 5 - Write the Program.

After the VXT software is installed, you will find the source code in the directory
below:

C:\Program Files\IVI Foundation\IV\Microsoft. NET\Framework64\v4.5.50709\
Keysight. KtM34Tx x.x.x\Examples\CSharp\CsPowerAcquisition.
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Write the Measurement Program

To output a LTE FDD signal with M941xA source, please refer to step b of
example 2.

To measure the channel power of the LTE signal, please refer to the example
code as below:

driver.Receiver.RF.Frequency = 1e9; //Set receiver center freq
driver.Receiver.RF.Power = -5;
driver.Receiver.RF.InputPort = Port.RFInput;

double RmsValue = driver.Source.Modulation.RmsPower;

double papr = -20 * Math.Logl@(RmsValue);

driver.Receiver.RF.PeakToAverage = papr;

//Highlight: RF.PeakerToAverage is very important to receiver setting, when test
a modulated siganl. You can calculate this value based on Modulation.ArbRmsValue,
when you play a waveform on VXT.

driver.Apply(); //Apply the above setting to VXT receiver hardware

driver.Receiver.AcquisitionMode = AcquisitionMode.Power; //choose power
acquisition mode to test power.
driver.Receiver.PowerAcquisition.Bandwidth = 10e6;
//PowerAcquisition.Bandwidth set to a value > DUT signals's bandwidth.
driver.Receiver.PowerAcquisition.Duration = 0.02;
driver.Receiver.PowerAcquisition.ChannelFilter.Shape = ChannelFilterShape.None;
driver.Receiver.PowerAcquisition.ChannelFilter.Alpha = 0.1;
driver.Receiver.PowerAcquisition.ChannelFilter.Bandwidth = 6e6;
//ChannelFilter.Bandwidth set to the DUT signal's bandwidth.
driver.Apply(); //Apply the above setting to VXTII receiver's hardware.
driver.Receiver.Arm();//Start the M941xA's receiver's measurement

if (!driver.WaitForData((6000))) // It will take some time to change receiver
setting, so use WaitForData() method to wait for a while.

{

throw new ApplicationException("WaitForData failed. No acquisition was
made.");
}

//Read the Channel Power's Measurement Result from VXTII memory, and Print it on
screen.

bool overloaded = false;

const int CAPTURE_ID = ©;

double power = 9;

driver.Receiver.PowerAcquisition.ReadPower(captureID: CAPTURE_ID, units:
PowerUnits.dBm, power: out power, overload: out overloaded);
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Commands Summary

Arm() method is used to trigger the data capture of acquisition. In this
example, after all the hardware parameters are set, use Arm() to enable the
power measurement. driver.Receiver.Arm() only triggers receiver's
action, while driver.Source.Arm() only triggers source's action.
Driver.Arm() triggers both the receiver and source's action together.

After Arm() method to capture data, a time delay is set to wait for the
measurement. PowerAquisition.ReadPower() is used to get the result
from VXT memory.

Bandwidth, Duration, Offsetfreq and ChannelFilter need to be
set in power acquisition mode.

Receiver.RF is used to set the basic RF parameters such as: center
freq, power (level), input port, and peak to average.Inall the
data acquisition modes, the commands to set those parameters are same.
For example, use commands below to set the receiver's RF parameters:

driver.Receiver.RF.Frequency = 1e9; //Set receiver’s center freq
driver.Receiver.RF.Power = -5; //Set receivers’ power range
driver.Receiver.RF.InputPort = Port.RFInput;

//Set the receiver’s RF input port

In benchtop spectrum analyzer, the reference, attenuator and pre-amplifier
is set to avoid mixer overload, or to control DANL. In VXT, only one
parameter RF.Power is used to set the power range of a receiver. Set
RF.Power value > DUT signal to avoid mixer overload. In example 4, DUT
LTE signal is -5 dBm, RF . Power is set to -b dBm. VXT will set attenuator
and pre-amp accordingly.

Receiver.RF.PeakToAverage is very important to test a signal with high
peak to average value, such as some cellular digital modulation signal. To
test a -5 dBm LTE signal, the average channel power of this signal will be -5
dBm, set Receiver.RF.Power to -5 dBm. However this LTE signal could
be 8 dB peak to average value, which means the peak signal power of this
LTE signal should be -3 dBm. It exceeds -5 dBm Receiver.RF.Power
setting, then the mixer will overload. The setting of
Receiver.RF.PeakToAverage will help to optimize the attenuator and
level setting in the mixer to get correct measurement result.

In the source code below:
double RmsValue = driver.Source.Modulation.RmsPower;

double papr = -20 * Math.Logl@(RmsValue);
driver.Receiver.RF.PeakToAverage = papr;

A waveform is played to generate this LTE signal, VXT provides a method to
read an ARB RMS value form the waveform, it is a peak to average volt ratio
value. It could be used to calculate power peak to average in dB unit.
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Get the Measurement Result

Refer to the process of step 7 in example 1 to build and run your program to
get the result as below.

MHeasure the Channel Power of a 5 MHz LTE Uplink Signal with Keysight UXTII M?41 x|N
]

m

Current SPI GConfig Ualue : BxBDriver Initialized

UATII H?41ixf Successfully Generated a 5 MHz LTE Uplink Signal.
Heasured Channel Power : —5.11935886245377

If want to measure again, please press Enter bhutton.

If Quit, please press stop.

Before running the program, please make sure the M9300A reference software
is turned on.

It will take several minutes to run the program as the VXT vector transceiver
need boot up before running this program.

Basic Concepts: 4 Receiver Acquisition Mode

Keysight VXT M941xA provides 4 receiver acquisition mode as below.

Features Use Case Difference
Power Acquisition  Get the channel power Fast power calculation
directly
Spectrum Get the spectrum data More data points than FFT acquisition
Acquisition based on span and RBW Lower DANL and better dynamic range
setting
FFT Acquisition FFT method to get the spec- Faster SA data capture speed than
trum data spectrum acquisition
Up to 512 data points
Lower dynamic range
IQ Acquisition |Q data output Easy for post analysis

All these 4 receiver acquisition mode related methods are included in
driver.Receiver menu.

Keysight VXT M941xA also provides 3 measurement mode: Power Servo,
ACPR, Harmonics. Please refer example 8, 9, and 10 for details.
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Example 5: Spectrum Acquisition

This example introduces the programming procedure to measure signal
spectrum data and search the maximum power point with VXT.

VXT source outputs a T GHz CW signal

VXT receiver tests the signal spectrum data and search the maximum power
point

Before programming, please connect VXT RF Output to RF Input port and VXT
100 MHz Ref In port to M9300A’s 100 MHz Ref Out port. Please refer to Figure
3-1 for details.

The programming procedure are listed as 8 steps as below:
Step 1. - Create your project with Visual C#

Step 2. - Add References

Step 3. - Add Using Statements

Step 4. - Create and initialize the Instance

Step 5. - Set VXT source to generate 1 GHz CW signal

Step 6. - Set VXT receiver to test signal spectrum data and search the
maximum power point.

Step 7. - Close the Instance
Step 8. - Build and Run the Program

Forstep 1, 2, 3, 4, b, 7, 8, pleas refer to example 1 as those steps are similar.
This section will only introduce the example code for step 6 - Set VXT receiver.

After the VXT software is installed, you will find the source code in the directory
below:

C:\Program Files\IVI Foundation\IV\Microsoft. NET\Framework64\v4.5.50709\
Keysight. KtM34Tx x.x.x\Examples\CSharp\CsSpectrumAcquisition.

48 Programmer’s Guide



Creating a Project with IVI.NET Using C#
Example 5: Spectrum Acquisition

Set VXT Receiver to Test Spectrum Data

To set VXT receiver to test the signal spectrum data and search the maximum
power point, please refer to the example code as below:

driver.Receiver.RF.Frequency = 1e9; //Set Receiver Center freq
driver.Receiver.RF.Power = -5; //Set power to -5 dBm
driver.Receiver.RF.InputPort = Port.RFInput;

driver.Apply(); //Apply the changes to hardware.

driver.Receiver.AcquisitionMode = AcquisitionMode.Spectrum; //Switch to Spectrum
Acquisition Mode.

driver.Receiver.SpectrumAcquisition.OffsetFrequency = 9;
driver.Receiver.SpectrumAcquisition.Span = 8e6; // Set Span of Spectrum
driver.Receiver.SpectrumAcquisition.ResolutionBandwidth = 30000; // Set RBW
driver.Receiver.SpectrumAcquisition.FFTWindowShape =
SpectrumFFTWindowShape.FlatTop; //Set FFT Window Shape
driver.Receiver.SpectrumAcquisition.Averaging.Mode = SpectrumAveraging.Time;
//Set Average's Mode - choose time based average.
driver.Receiver.SpectrumAcquisition.Averaging.Duration = 0.5; //Set average based
time.

driver.Receiver.SpectrumAcquisition.Averaging.Overlap = 0.5; //Set overlap value.

driver.Apply();

//Apply above receiver parameters' setting
driver.Receiver.Arm();

// Arm the digitizer to start measurement or data capture

const int CAPTURE_ID = ©;

double[] spectrum = new double[driver.Receiver.SpectrumAcquisition.Bins];

double fstart 0;

double fdelta = ©; //Read the Spectrum data from VXTII's memory.
driver.Receiver.SpectrumAcquisition.ReadPowerSpectrum(CAPTURE_ID, PowerUnits.dBm,
ref spectrum, out overloaded, out fstart, out fdelta);

Search maximum data point. Source code:
int maxBin = FindMaximumAmplitude(ref spectrum);
private static int FindMaximumAmplitude(ref double[] vector)
{
Double maxValue = Double.MinValue;
int bin = -1;
for (int i = @; i < vector.Length; i++)
{
if (vector[i] > maxValue)
{
bin = i;
maxValue = vector[i];

}

return bin;
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Commands Summary

e driver.Receiver.SpectrumAcquisition.Bins is used to get the number
of frequency points captured by the spectrum acquisition mode. When
you set the Span and RBW value, the VXT will set the frequency bins value
automatically. Increase span and decrease RBW will result in a larger Bin
value, which means more frequency points.

you program will assign enough space to save the spectrum data, based
on Bin’s value.
. driver.Receiver.SpectrumAcquisition.ReadPowerSpectrumis used to

read spectrum acquisition. The default unit is dBm. The spectrum data
captured by FFT acquisition mode is in mW unit.

Get the Measurement Result

Refer to the process of step 7 in example 1 to build and run your program to
get the result as below.

Meazsure the Spectrum of Current BSignal with Keysight UXTII M?41xh
Find the Peak Power Point of Current CW Signal

m| »

Current SPI Config Value : BxBDriver Initialized

UHATII M?41xA Successfully Generated a 1 GHz CW Signal.

Read 1824 Spectrum Data binz, the maximum amplitude is at hin 511 with amplitude
-4.78 dBm.

If you want to test again. please press Enter button.

Before running the program, please make sure the M9300A reference software
is turned on.

It will take several minutes to run the program as the VXT vector transceiver
need boot up before running this program.
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Example 6: FFT Acquisition

This example introduces the programming procedure to measure signal
spectrum data and search the maximum power point with VXT.

VXT source outputs a T GHz CW signal

VXT receiver tests the signal spectrum data in FFT mode and search the
maximum power point

Before programming, please connect VXT RF Output to RF Input port and VXT
100 MHz Ref In port to M9300A’s 100 MHz Ref Out port. Please refer to figure
3-1 for details.

The programming procedure are listed as 8 steps as below:
Step 1. - Create your project with Visual C#

Step 2. - Add References

Step 3. - Add Using Statements

Step 4. - Create and initialize the Instance

Step 5. - Set VXT source to generate 1 GHz CW signal

Step 6. - Set VXT receiver to test signal spectrum data in FFT mode and search
the maximum power point.

Step 7. - Close the Instance
Step 8. - Build and Run the Program

Forstep 1, 2, 3, 4, b, 7, 8, pleas refer to example 1 as those steps are similar.
This section will only introduce the example code for step 6 - Set VXT receiver.

After the VXT software is installed, you will find the source code in the directory
below:

C:\Program Files\IVI Foundation\IVA\Microsoft. NET\Framework64\v4.5.50709\
Keysight. KtM34Tx x.x.x\Examples\CSharp\CsFFTAcquisition.
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Set VXT Receiver

To set VXT receiver to test the signal spectrum data in FFT mode and search
the maximum power point, please refer to the example code as below:
driver.Receiver.RF.Frequency = 1e9;
driver.Receiver.RF.Power = -5;
driver.Receiver.RF.InputPort = Port.RFInput;
driver.Receiver.RF.PeakToAverage = 3;
//PeakerToAverage is very important to receiver setting, when test a modulated
siganl. You can calculate this value based on Modulation.ArbRmsValue, if you play
a waveform on VXT. In this code, set the ReakToAverage value to 3 dB.

driver.Receiver.AcquisitionMode = AcquisitionMode.FFT;
driver.Receiver.FFTAcquisition.Length = FFTAcquisitionLength.Length_512;
driver.Receiver.FFTAcquisition.SampleRate = 5e6; //Sample rate should be set to a
value > 1.25 x Span.

driver.Receiver.FFTAcquisition.WindowShape = FFTWindowShape.FlatTop;
driver.Receiver.FFTAcquisition.Duration = le-4;
driver.Receiver.FFTAcquisition.ChannelFilter.Shape = ChannelFilterShape.None;
driver.Receiver.FFTAcquisition.ChannelFilter.Bandwidth = 4e6;
driver.Receiver.FFTAcquisition.ChannelFilter.Alpha = 0.1;

driver.Apply(); //Apply the changes to hardware.

driver.Receiver.Arm(); //Arm the digitizer

Double[] fftData = new Double[driver.FFTAcquisition.Samples];
driver.Receiver.FFTAcquisition.ReadMagnitudeData(@, ref fftData, out overloaded);

TodBm(ref fftData); //this method switch the FFT result into dBm value.
int maxBin = FindMaximumAmplitude(ref fftData); //This method find the peak power
value.

private static void TodBm(ref double[] vector)

{

for (int i = @; i < vector.Length; i++)

{

vector[i]

10 * Math.Logle(vector[i]);
}

52 Programmer’s Guide



Programmer’s Guide

Creating a Project with IVI.NET Using C#
Example 6: FFT Acquisition

Commands Summary

» driver.Receiver.FFTAcquisition.Length is limited up to 512 points to get
fast test speed. To get more frequency points, please use spectrum
acquisition mode.

* driver.Receiver.FFTAcquisition.ReadMagnitudeData is used to read
spectrum acquisition. The default unit is dBm. The spectrum data captured
by FFT acquisition mode is in mW unit.

Get the Measurement Result

Refer to the process of step 7 in example 1 to build and run your program to
get the result as below.

gest the Spectrum of a CUW Signal with Heysight UXTII M?41xA’= FFT Acguisition Mo

m| s

e
Find the Feak Power Ualue in Spectrum
Current SPI Config Ualue : BxBDriver Initialized

URTII M?41xA Successfully Generated a 1GHz CW Signal.
Read 512 FFT bins. the maximum amplitude iz at bin 256 with amplitude —-4.89 dBm.

Before running the program, please make sure the M9300A reference software
Is turned on.

It will take several minutes to run the program as the VXT vector transceiver
need boot up before running this program.
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Example 7: 1Q Acquisition

This example introduces the programming procedure to measure signal
channel power with M941xA.

VXT source outputs a LTE FDD signal
VXT receiver captures signal’s |Q data

The license key of N7624B Signal Studio is needed to play a LTE FDD signal
with VXT product.

Before programming, please connect VXT RF Output to RF Input port and VXT
100 MHz Ref In port to M9300A’s 100 MHz Ref Out port. Please refer to figure
3-1 for details.

The programming procedure are listed as 8 steps as below:
Step 1. - Create your project with Visual C#

Step 2. - Add References

Step 3. - Add Using Statements

Step 4. - Create and initialize the Instance

Step b. - Set VXT source to generate 1 GHz LTE FDD signal
Step 6. - Set VXT receiver to capture signal’s IQ data.

Step 7. - Close the Instance

Step 8. - Build and Run the Program

Forstep 1, 2, 3, 4, b, 7, 8, pleas refer to example 1 as those steps are similar.
This section will only introduce the example code for step 6 - Capture 1Q Data.

After the VXT software is installed, you can find the source code as below:

C:\Program Files\IVI Foundation\IVAMicrosoft. NET\Framework64\v4.5.50709\
Keysight. KtM34Tx x.x.x\Examples\CSharp\CslIQAcquisition.
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Write the Measurement Program
To output a LTE FDD signal with M941xA source, please refer to Example 2.

To capture the IQ data of the LTE signal, please refer to the example code as
below:
driver.Receiver.RF.Frequency = 1e9; //Set the Receiver's Center Freq.
driver.Receiver.RF.Power = 0;
driver.Receiver.RF.InputPort = Port.RFInput; //set the Receiver to RF input
port.

double RmsValue = driver.Source.Modulation.RmsPower;

double papr = -20 * Math.Logl@(RmsValue);

driver.Receiver.RF.PeakToAverage = papr;

// read the RMS value from waveform file and transfer it into Peak to Avearge
Ratio Value(PAR).

//Need to set a proper receiver RAR value. If the DUT signal's PAR is higher
than receiver, the receiver may overload!

driver.Receiver.AcquisitionMode = AcquisitionMode.IQ;

//choose data acquirement mode to IQ Acquisition Mode
driver.Receiver.IQAcquisition.SampleRate = 5000000; //Set Sample Rate
double DURATION = le-3;

double SAMPLE_RATE = driver.Receiver.IQAcquisition.SampleRate;
driver.Receiver.IQAcquisition.Samples = (int)(DURATION * SAMPLE_RATE);

//Set the IQ data acquisition sample number.

int samples = driver.Receiver.IQAcquisition.Samples;
driver.Receiver.IQAcquisition.ChannelFilter.Shape = ChannelFilterShape.None;
//Set the IQ Acquisition's channel filter shpe

driver.Apply(); //Apply the changes to hardware.

driver.Receiver.Arm();

//Arm the digitizer to start measurement or data capture

//After Arm() method, the IQ data will be captured into VXTII's memory, and we
will use IQAcquisition.ReadIQData() method to read the data.

double[] interleavedIgBlock = null; // Allocate enough room for 5,000 samples

Console.WriteLine("Start to Capture IQ data:");
driver.Receiver.IQAcquisition.ReadIQData(@, IQUnits.SquareRootMilliWatts, O,
samples, ref interleavedIgBlock, out overloaded);

//Read the captured IQ data from VXT.

//Add code to process this IQ data per your own requirement.
Console.WriteLine("Read {0,5} samples from VXT M941xA. IQ data capture
completed.", samples);

driver.Receiver.IQAcquisition.Samples is used to set the sample points
you want to capture, so you can defined a number directly. Usually we can
define it according to IQAcquisition.SampleRate and Duration Time you
want to test. So in source code, it set as below,
driver.Receiver.IQAcquisition.Samples = (int) (DURATION *
SAMPLE_RATE) ;

//Set the 1Q data acquisition sample number.
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Get the Measurement Result

Refer to the process of step 7 in example 1 to build and run your program to
get the result as below.

Capture the IQ data of a 5 MHz LTE Uplink Signal with Keysight UXTII M?41xA

m | »

Current SPI Config Ualue : Bx@Driver Initialized
UETII M?41xA Successfully Generated a 5 MHz LTE Uplink Signal.

Start to Capture IQ d
Read 58B@ samples Plum UHTII M34ixA. IQ data capture completed.

Before running the program, please make sure the M9300A reference software
is turned on.

It will take several minutes to run the program as the VXT vector transceiver
need boot up before running this program.
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Example 8: Power Servo Measurement

This example introduces the programming procedure to perform power servo,
and DUT is only a cable.
Power Servo Loop

One of the key measurements for a power amplifier or chip set, is performing a
Servo Loop. Because when you measure a power amplifier or chip set, it is
typically specified at a specific output power level. It needs to adjust the source
input level until you measure the exact power level. To do this, you will
continually adjust the source until you achieve the specified output power

level.

NOTE In this example, need to generate a WCDMA uplink signal with VXT’s source,
so the license key of N7600B Signal Studio is needed with VXT product.

Before programming, please connect VXT RF Output to RF Input port and VXT
100 MHz Ref In port to M9300A’'s 100 MHz Ref Out port. Please refer to figure
3-1 for details.

The programming procedure are listed as 8 steps as below:

Step 1. - Create your project with Visual C#

Step 2. - Add References

Step 3. - Add Using Statements

Step 4. - Create and initialize the Instance

Step 5. - Set VXT source to generate 1 GHz WCDMA Uplink signal
Step 6. - Perform Power Servo operation.

Step 7. - Close the Instance

Step 8. - Build and Run the Program

Forstep 1, 2, 3, 4, 5, 7, 8, pleas refer to example 1 as those steps are similar.
This section will only introduce the example code for step of Write the
Program.

After the VXT software is installed, you can find the source code as below:

C:\Program Files\IVI Foundation\IV\Microsoft. NET\Framework64\v4.5.50709\
Keysight.KtM941x x.x.x\Examples\CSharp\CsMeasurement_PowerServo.
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Write the Measurement Program

To output a WCDMA uplink signal with the M941xA source, please refer to
below source codes:

driver.Source.RF.Frequency = 1e9;

driver.Source.RF.Level = -20;

//Set source's original output power level to perform power servo.
driver.Source.RF.OutputPort = Port.RFOutput;

driver.Source.RF.OutputEnabled = true;
driver.Source.LoadWaveform("..\\..\\..\\", "WCDMA_UL_DPCHH_2DPDCH_1C.wfm");
//Because the waveform file WCDMA_UL_DPCHH_2DPDCH_1C.wfm, is put in the root folder of
current project, the LoadWaveform's address is "..\\..\\..\\".
driver.Source.Modulation.PlayArb("WCDMA_UL_DPCHH_2DPDCH_1C.wfm",
StartEvent.Immediate);

driver.Source.Modulation.Enabled = true;

driver.Apply();

The waveform file “WCDMA_UL_DPCHH_2DPDCH_T1C.wfm” used in this
example is attached in the project file. You can set it to other address in
Source.LoadWaveform().

Example Code » CS_PowerServo »

EFEeg
. &R i e
bin 2016/
| obj 2016/
Properties 2016/
':_,Tﬂ CS_PowerServo.csproj 2016/
3 CS_PowerServo.sin 2016/
CS_PowerServo.sin.docstates.suo 2016/
CS_PowerServo.suo 2016/
oi) Program.cs 2016/

WCDMA_UL_DPCHH_2DPDCH_1C.wfm 2015/
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To perform power servo operation, please refer to the example code as below:

// Setup Receiver

driver.Receiver.RF.Frequency = 1e9;

driver.Receiver.RF.Power = 5;

double RmsValue = driver.Source.Modulation.RmsPower;

double papr = -20 * Math.Logl@(RmsValue);

driver.Receiver.RF.PeakToAverage = papr;

//Set the Peak to Average value according to RMS power of waveform loaded in the
source's modulator

driver.Receiver.RF.InputPort = Port.RFInput;

driver.Apply();

//Configure Power Servo

driver.Measurement.PowerServo.AcquisitionMode = AcquisitionMode.FFT;
driver.Receiver.FFTAcquisition.SampleRate = 30.72e6;
driver.Receiver.FFTAcquisition.Length = FFTAcquisitionLength.Length_512;
driver.Receiver.FFTAcquisition.Duration = 0.0001;
driver.Receiver.FFTAcquisition.WindowShape = FFTWindowShape.Gaussian;

ChannelFilterShape FilterType = ChannelFilterShape.RaisedCosine;

double FilterAlpha = 0.22;

double FilterBw = 3840000.0;
driver.Receiver.FFTAcquisition.ChannelFilter.Configure(FilterType, FilterAlpha,
FilterBw);

double Level = -20; double Gain = 5;
driver.Measurement.PowerServo.InputPower = Level + Gain;
driver.Measurement.PowerServo.OutputPower = Level;
driver.Measurement.PowerServo.OutputPowerMargin = 0.05;
driver.Measurement.PowerServo.OverheadTime = 600e-6;
driver.Measurement.PowerServo.MaximumQutputPower = 20;

driver.Source.Apply();//Apply source's setting to VXT's source
driver.Receiver.Apply();/Ch/Apply receiver's setting to VXT's receiver

Measurements[] measlist = new Measurements[] { Measurements.PowerServo };
driver.Measurement.SetEnableList(measlist);

//choose measurement mode, Power Servo in this case, then load Measurement related
parameters to VXT receiver's hardware.

driver.Measurement.Process();//Active the measurement
double MeasuredPower = 0;

bool ServoPass = false;

int ServoCount = 0;

bool Overload = true;

//Read Power Servo Result
driver.Measurement.PowerServo.ReadPowerServo(out MeasuredPower, out ServoPass, out
Overload, out ServoCount);
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Commands Summary

In this power servo example, the driver.Arm() method is not used to
active the measurement. We used the driver.measurement.process()
method.

The driver.Arm() method is mainly used for the 4 basic acquisition
modes, Power acquisition, FFT acquisition, spectrum acquisition and 1Q
acquisition. It will enable the test without any time delay or waiting.

The driver.measurement.process() is mainly used to active the 3
measurement function, Power Servo, Harmonics and ACPR. A basic data
acquisition operation only perform one time data acquisition, so we use
driver.Arm(). The 3 measurements function will perform several times
data acquiring to output a result. Take Harmonics for example, it tests the
main signal and harmonics signal amplitude one by one. So the
measurement will use measurement.process() method.

The driver.measurement.SetEnablelList()is used to choose measure
mode, Power Servo, Harmonics or ACPR, and load the measurement
related parameters to VXT receiver's hardware. Driver.Apply () only
apply or load source and receiver's parameters, so it will not load
Measurement related parameters. In this example case,
driver.Receiver.Apply(), driver.Measurement.SetEnableList(),
and driver.Measurement.Process() are used after setting all the
receiver and measurement parameters.

The 3 measurements items are tested based on 1 of 4 basic acquisition
modes, so it requires to choose the
Measurement.PowerServo.AcqusitionMode, and set related parameters
in this mode.

Get the Measurement Result

Refer to the process of step 7 in example 1 to build and run your program to
get the result as below.

The measured power is —=14.98 dBm, and the servo count is 4.

Use Heysight UKTII M9?4ixA to Perform Pouwer Servo -
Current SPI Gonfig Value : Bx@Driver Initialized

Press Enter to Run Test
Measured Power —10.4658558821318dbm . Servo pass is False. Servo Count is B, Ser|

wo Ouerload is False
Repeat? w-n

iy
Press Enter to RBun Test

Measured Power —15.3217185%88556%dbm . Servo pass is False, Sewrwo Count is 1, Ser|
wo Ouerload is False
Repeat? wsn

Before running the program, please make sure the M9300A reference software
Is turned on.

It will take several minutes to run the program as the VXT vector transceiver
need boot up before running this program.
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Example 9: Harmonics Measurement

Programmer’s Guide

This example introduces the programming procedure to measure harmonics of
a CW signal with M941xA.

VXT source outputs a T GHz CW signal
VXT receiver test harmonics of this signal

Before programming, please connect VXT RF Output to RF Input port and VXT
100 MHz Ref In port to M9300A’'s 100 MHz Ref Out port. Please refer to figure
3-1 for details.

The programming procedure are listed as 8 steps as below:
Step 1. - Create your project with Visual C#

Step 2. - Add References

Step 3. - Add Using Statements

Step 4. - Create and initialize the Instance

Step 5. - Set VXT source to generate 1 GHz CW signal
Step 6. - Set VXT receiver to test the harmonics.

Step 7. - Close the Instance

Step 8. - Build and Run the Program

Forstep 1, 2, 3, 4, 5, 7, 8, pleas refer to example 1 as those steps are similar.
This section will only introduce the example code for step 6 - Set VXT receiver
to test harmonics.

After the VXT software is installed, you can find the source code as below:

C:\Program Files\IVI Foundation\IV\Microsoft. NET\Framework64\v4.5.50709\
Keysight.KtM941x x.x.x\Examples\CSharp\CsMeasurement_Harmonics.
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Write the Measurement Program

To output a CW signal with VXT source, please refer to Example 1.

To test the harmonics of this signal, please refer to below source codes:

driver.Receiver.RF.Frequency = 1e9;
driver.Receiver.RF.Power = 10;

//Set the Receiver.RF.Power a little bigger than target test signal to avoid

overload
valuedriver.Receiver.RF.PeakerToAverage =3;
driver.Receiver.RF.InputPort = Port.RFInput;

//Use spectrum mode to test harmonics and set spectrum parameters
driver.Measurement.Harmonics.AcquisitionMode = AcquisitionMode.Spectrum;

driver.Receiver.SpectrumAcquisition.Span = 1le6;

driver.Receiver.SpectrumAcquisition.ResolutionBandwidth = 1e3;

driver.Receiver.SpectrumAcquisition.FFTWindowShape =
SpectrumFFTWindowShape.Hann;

driver.Apply();// Apply the above setting to VXTII receiver's hardware.

driver.Measurement.Harmonics.Configure(fundamentalFrequency:
driver.Source.RF.Frequency,maximumHarmonicsNumber: 3);

//Configure Harmonic measurement parameters, the fundament frequency and max

harmonics numbers.

Measurements[] measlist = new Measurements[] { Measurements.Harmonics };

driver.Measurement.SetEnableList(measlist);

//Choose the measurement mode, then load related parameters to VXT receiver's

hardware.

driver.Measurement.Process();
//Active the harmonics measurement.

bool overload = false;
double[] harmData = new double[5];
bool[] overloads = new bool[5];

driver.Measurement.Harmonics.ReadHarmonics(Harmonics: ref harmData, Overload:

ref overload);

//Read Harmonics test result. The output is the power of main signal and

harmonics in dBm unit.
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Commands Summary

Maximum Harmonics Number is to set the number of harmonics will be
tested, default vaule is 1. Please take note it includes the fundamental
frequency signal. For example, if you set the
driver.Measurement.Harmonics.MaxmumHarmonicsNumber to 3 to test
a1 GHz CW signal, it will test the power level of 1T GHz(fundamental freq), 2
GHz and 3 GHz signal.

Measurement.Harmonics.ReadHarmonics() is used to read the
Harmonics test result, and the result is only in dBm unit. If you want to get
the result in dBc unit, such as 2nd Harmonics is XX dBc related to
fundamental signal, you need to calculate with your own code

Because the Harmonics test usually requires high dynamic range, please
carefully adjust driver.receiver.RF.power to achieve a better result.

IQ Acquisition mode is not supported by Harmonics measurement mode.

Get the Measurement Result

Refer to the process of step 8 in example 1 to build and run your program to
get the result as below.

CS_Measurement_Harmonics

m| s

Current SPI Config Ualwe : BxBDriver Initialized

URATII M?4ixA Buccessfully Generated 1 GHz -18 dBm CW Signal.

Amplitude of Fundamental Frequency is
—18.6375853143825 dBm

Harmonic 2= —41.8714183784422 dBm
Harmonic 3= -39.28541162610844 dBm
If youw want to test again, please press Enter button.

Before running the program, please make sure the M9300A reference software
is turned on.

It will take several minutes to run the program as the VXT vector transceiver
need boot up before running this program.
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Example 10: ACPR Test

64

This example introduces the programming procedure to measure ACPR of a
LTE FDD signal with MO41xA.

VXT source outputs a LTE FDD signal
VXT receiver test ACPR of this signal

Before programming, please connect VXT RF Output to RF Input port and VXT
100 MHz Ref In port to M9300A’'s 100 MHz Ref Out port. Please refer to figure
3-1 for details.

The programming procedure are listed as 8 steps as below:
Step 1. - Create your project with Visual C#

Step 2. - Add References

Step 3. - Add Using Statements

Step 4. - Create and initialize the Instance

Step 5. - Write the Program (Set VXT source to generate LTE FDD signal, and
set VXT receiver to test the ACPR of this signal)

Step 6. - Close the Instance
Step 7. - Build and Run the Program

Forstep 1, 2, 3, 4, 6, 7, please refer to example 1 as those steps are similar.
This section will only introduce the example code for step 5 - Write the
Program.

After the VXT software is installed, you can find the source code as below:

C:\Program Files\IVI Foundation\IVAMicrosoft. NET\Framework64\v4.5.50709\
Keysight. KtM941x x.x.x\Examples\CSharp\CsMeasurement_ACPR.
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Write the Measurement Program
To output a CW signal with VXT source, please refer to Example 2.

To test the harmonics of this signal, please refer to below source codes:

//Set Receiver

driver.Receiver.RF.Frequency = 1le9;

driver.Receiver.RF.Power = -10;

//the Receiver.RF.Power should be set equal to the target test value, to get
exact test result.

double RmsValue = driver.Source.Modulation.RmsPower;

double papr = -20 * Math.Logl@(RmsValue);

// read the RMS value from waveform file and transfer it into Peak to Avearge
Ratio Value(PAR).

driver.Receiver.RF.PeakToAverage = papr;

//Need to set a proper receiver RAR value.

//If the DUT signal's PAR is higher than receiver, the receiver may overload!!
driver.Apply();

//User Power mode

driver.Measurement.Acpr.AcquisitionMode = AcquisitionMode.FFT;
driver.Measurement.Acpr.UseChanPwrForRef = false;

//VXTII could use power servo channel power result as the carrier channel power
to test ACPR.

//This will help to improve the test speed if customer want to perform
powerservo and then test ACPR.

//This example will only show how to test ACPR, so the UseChanPwrForRef set to
false.

int numAcprMeas = 3;

//In this code, we will test 2 adjcent channels(1l lower and 1 upper), so 3
channel powers will be tested to get 2 ACPR results.

double[] AcprOffsetFreq = new double[] { @, -5e6, 5e6 };

double[] AcprSpan = new double[] { 4.5e6, 4.5e6, 4.5e6 };

double[] AcprDuration = new double[] { 500e-6, 500e-6, 500e-6 };
ChannelFilterShape[] AcprFilterType = new ChannelFilterShape[numAcprMeas];
AcprFilterType[@] = ChannelFilterShape.Rectangular;

AcprFilterType[1] ChannelFilterShape.Rectangular;

AcprFilterType[2] ChannelFilterShape.Rectangular;

double[] AcprAlpha = new double[] { ©.22, 0.22, 0.22 };

double[] AcprBandWidth = new double[] { 3.84e6, 3.84e6, 3.84e6 };

Measurements[] measlist= new Measurements[]{Measurements.Acpr};
driver.Measurement.Acpr.SetAcprParameter (AcprOffsetFreq, AcprSpan,

AcprDuration);
driver.Measurement.Acpr.AveragingNumber = 1;
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driver.Measurement.Acpr.ConfigureFilter(AcprFilterType, AcprAlpha, AcprBandWidth);
driver.Measurement.SetEnableList(measlist);

//Choose the measurement mode, then load related parameters to VXT receiver's
hardware.

driver.Measurement.Process();

//Active the harmonics measurement.

double[] AcprResultPower = new double[numAcprMeas];

bool[] AcprResultOverload = new bool[numAcprMeas];

// Read acpr result

driver.Measurement.Acpr.ReadAcpr(ref AcprResultPower, ref AcprResultOverload)

// Print Results
Console.WriteLine("Main Channel Power:
" dBm/4.5 MHz");

//Print reference signal power
Console.WriteLine("Offset Freq 5 MHz, Lower:"+AcprResultPower[1]+"dBC/4.5 MHz");
Console.WriteLine("Offset Freq 5 MHz, Lower:"+AcprResultPower[2]+"dBC/4.5 MHz");
//0utput 2 adjacent channel powers

+ driver.Measurement.Acpr.ReferencePower +

Commands Summary

driver.Measurement.Acpr.UseChanPwrForRef is a special setting for VXT’s
ACPR measurement. If it set to true, VXT will use Power servo’s power
result as carrier channel’s power to perform ACPR test. Because VXT is
designed to perform high speed measurement. When customer test a
amplifier, it requires to perform power servo and ACPR for same DUT. VXT
support to use power servo’s power result as carrier channel’'s power to
perform ACPR, so it will help to decrease the total measurement time.

If you don’t need to perform Power Servo (such as transmitter or base
station test) before ACPR test, should set the
driver.Measurement.Acpr.UseChanPwrForRef to false. Current example is
this case.

Measurement.Acpr.ReadAcpr will get a AcprResultOverload value, and it
will help to check whether you have received correct result. If the
AcprResultOverload get true, the ACPR power result will be incorrect as the
VXT has already overloaded.
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Measurement Result

Refer to the process of step 7 in example 1 to build and run your program to
get the result as below.

VXT test the ACPR result as below:

Meazure the ACPR of a 5 MHz LTE Uplink Signal with Keysight UXTII M?41xA

m| s

Current SPI Config Value : BxBADriver Initialized

WAETII M?41xA Successfully Generated a 5 MHz LTE Uplink Signal.
ACPR Result — LTE FDD S5MH=z Uplink

Main Channel Power: —160.1424180345244 dBm-4.5% MH=
Of fzet Freq 5 MHz. Lower: —57.1478872325531 dBC ~ 4.5 MH=
Of fzet Freq 5 MHz. Lower: -56.9226491835598 dBC ~ 4.5 MH=

Before running the program, please make sure the M9300A reference software
is turned on.

It will take several minutes to run the program as the VXT vector transceiver
need boot up before running this program.
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Example 11: Combined WCDMA Power Servo and ACPR Measurement

In Power Servo and ACPR measurement, Servo is performed by "Baseband
Tuning" to adjust the source amplitude and then "Baseband Tuning" is used to
digitally tune the center frequency in order to make channel power
measurements, at multiple offsets, using the Power Servo interface of the VXT.

The following example code demonstrates how to instantiate driver instances,
set the resource names and various initialization values, initialize the driver
instances, and perform the other relevant tasks:

Send source RF and LoadWaveform commands to the VXT driver
Send receiver RF commands to the VXT driver

Send measurement process command to run a Servo loop and ACPR
measurement

Read the measurement result and close the driver

Before programming, please connect VXT RF Output to RF Input port and VXT
100 MHz Ref In port to M9300A’s 100 MHz Ref Out port. Please refer to figure
3-1 for details.

After the VXT software is installed, you can find the source code as below:

C:\Program Files\IVI Foundation\IV\Microsoft. NET\Framework64\v4.5.50709\
Keysight. KtM34Tx x.x.x\Examples\CSharp\CsPowerServo_ACPR.

Example Program - Pseudo - code

Initialize drivers for VXT and check for errors

Configure Source RF Settings:
Frequency
RF Level
RF Output Port and Enable On
Configure ARBPLAY Settings:
Load WCDMA Signal Studio File
Get RMS Value
Play ARB File
Configure Receiver RF Settings:
Frequency
Level
Peak to Average Ratio

Input Port
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Configure Power Servo Settings
Enable Power Servo Measurement
Acquisition Mode
Acquisition Settings
Power Servo Settings

Configure ACPR Settings
Enable ACPR Measurement
ACPR Measurement Settings

Enable VXT Settings:

Source Settings
Receiver Settings

Apply All Above Settings and Measurements

Read Power Servo Results
Measured Power
Pass/Fail
Overload
Servo Count

Read ACPR Results
ACPR Values

Overload

Source Code

// Copy the following example code and compile it as a C# Console Application
#region Specify using Directives

using System;

using System.Collections.Generic;

using System.Linq;

using System.Text;

using Keysight.KtM941x;

#endregion

namespace CS_PowerServo_ACPR
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class Program

{

static void Main(string[] args)
{
// Create driver instances
Console.WriteLine("Perform Power Servo, then Measure ACPR");
KtM941x driver = null;
try
{

#region Initialize Driver Instances

string ResourceName

bool IdQuery = true;

bool Reset = true;

string OptionString
DriverSetup= Model=M941xAe";

driver = new KtM941x(ResourceName, IdQuery, Reset, OptionString);

Console.WriteLine("Driver Initialized\n");

#endregion

"PXI21::0::0::INSTR";

"QueryInstrStatus=true, Simulate=false,

#region Check Instrument Queue for Errors

int errorcode = 0;
string message = string.Empty;
// Check instrument for errors

do
{
Ivi.Driver.ErrorQueryResult err = driver.Utility.ErrorQuery();
message = err.Message;
if (errorcode != 0)
{
Console.WriteLine(message);
}
} while (errorcode != 9);
#endregion

#region Create Default Settings for WCDMA Uplink Signal

// Source Settings

double Frequency = 1000000000.0;

double Level = -20;

double Gain = 5;

double PowerOutMargin = 0.05;

double ServoOverheadTime = 600e-6;

//Software License is needed if a Signal Studio waveform file is used.
string WaveformFile = "WCDMA_UL_DPCHH_2DPDCH_1C.wfm";
string ExamplesFolder = "..\\..\\..\\"; // Because we put this waveform

in the sample code project's root folder, we use this address.
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// Receiver Settings

double ChannelTime = 0.0001;

double AdjacentTime = 0.0005;

double IfBandwidth = 40000000.0;

double MeasureBW = 5000000.0;

ChannelFilterShape FilterType = ChannelFilterShape.RaisedCosine;

double FilterAlpha = 0.22;

double FilterBw = 3840000.0;

double AcprFliterBw = 3840000.0;

double AcprFilterAlpha = 0.22;

ChannelFilterShape AcprFilterType =
ChannelFilterShape.RaisedCosine;

double[] FreqOffset = new double[] {-5000000.0, 5000000.0,
-10000000.0, 10000000.0};

double[] acprFilterAlpha = new double[4] {AcprFilterAlpha,
AcprFilterAlpha, AcprFilterAlpha, AcprFilterAlpha};

double[] acprFilterBw = new double[4] {AcprFliterBw,
AcprFliterBw, AcprFliterBw, AcprFliterBw};

ChannelFilterShape[] acprFilterType = new ChannelFilterShape[]
{AcprFilterType, AcprFilterType, AcprFilterType, AcprFilterType};

double AcprSpan = 30.72e6 / 1.25;

double AcprDuration = AdjacentTime;

double[] acprSpan = new double[4] {AcprSpan, AcprSpan, AcprSpan,
AcprSpan};

double[] acprDuration = new double[4] {AcprDuration,
AcprDuration, AcprDuration, AcprDuration};

double MeasuredPower = 0;

bool ServoPass = false;

int ServoCount 0;

bool Overload = true;

double[] MeasuredACPR = new double[5];

bool[] MeasuredACPROverload = new bool[5];

double RmsValue = 0;

#endregion

#region Run Commands

//Setup Source

driver.Source.LoadWaveform(ExamplesFolder, WaveformFile);

RmsValue = driver.Source.Modulation.RmsPower;

double papr = -20 * Math.Logl@(RmsValue);

driver.Source.RF.Frequency = Frequency;

driver.Source.RF.Level = Level;

driver.Source.RF.OutputPort = Port.RFOutput;

driver.Source.RF.OutputEnabled = true;

driver.Source.Modulation.PlayArb("WCDMA_UL_DPCHH_2DPDCH_1C.wfm",

StartEvent.Immediate);
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driver.Source.Modulation.Enabled = true;
driver.Apply();

// Setup Receiver
driver.Receiver.RF.Frequency = Frequency;
driver.Receiver.RF.Power = Level + Gain;
driver.Receiver.RF.PeakToAverage = papr;
driver.Receiver.RF.InputPort = Port.RFInput;

// Configure PowerServo
driver.Measurement.PowerServo.AcquisitionMode = AcquisitionMode.FFT;
driver.Receiver.FFTAcquisition.SampleRate = 30.72e6;
driver.Receiver.FFTAcquisition.Length =
FFTAcquisitionLength.Length_512;
driver.Receiver.FFTAcquisition.Duration = ChannelTime;
driver.Receiver.FFTAcquisition.WindowShape =
FFTWindowShape.Gaussian;
driver.Receiver.FFTAcquisition.ChannelFilter.Configure(FilterType,
FilterAlpha, FilterBw);
driver.Measurement.PowerServo.InputPower = Level + Gain;
driver.Measurement.PowerServo.OutputPower = Level;
driver.Measurement.PowerServo.OutputPowerMargin = PowerOutMargin;
driver.Measurement.PowerServo.0OverheadTime = ServoOverheadTime;
driver.Measurement.PowerServo.MaximumOutputPower = 20;

//Configure Acpr

driver.Measurement.Acpr.AcquisitionMode = AcquisitionMode.FFT;

driver.Measurement.Acpr.UseChanPwrForRef = true;

driver.Measurement.Acpr.ConfigureFilter(acprFilterType,
acprFilterAlpha, acprFilterBw);

driver.Measurement.Acpr.SetAcprParameter(FreqOffset, acprSpan,
acprDuration);

Measurements[] measlist = new Measurements|[]
{Measurements.PowerServo, Measurements.Acpr};
driver.Measurement.SetEnableList(measlist);

string response = "y";
while (string.Compare(response, "y") == 0)
{

Console.WriteLine("Press Enter to Run Test");
Console.ReadLine();

//Process measurement
driver.Measurement.Process();

// Check instrument for errors

do
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Ivi.Driver.ErrorQueryResult err =
driver.Utility.ErrorQuery();
message = err.Message;

if (errorcode != 9)
{
Console.WriteLine(message);
}
} while (errorcode != 9);

//Read PowerServo

driver.Measurement.PowerServo.ReadPowerServo(out
MeasuredPower, out ServoPass, out Overload, out ServoCount);

Console.WriteLine("Measured Power {@}dbm , Servo pass is {1},

Servo Count is {2}, Servo Overload is {3}", MeasuredPower, ServoPass,
ServoCount, Overload);

driver.Measurement.Acpr.ReadAcpr(ref MeasuredACPR, ref
MeasuredACPROverload);

Console.WriteLine("ACPR1 L: {@} dBc, Overload is {1}",
MeasuredACPR[@], MeasuredACPROverload[0]);

Console.WritelLine("ACPR1 U: {@} dBc, Overload is {1}",
MeasuredACPR[1], MeasuredACPROverload[1]);

Console.WritelLine("ACPR2 L: {@} dBc, Overload is {1}",
MeasuredACPR[2], MeasuredACPROverload[2]);

Console.WritelLine("ACPR2 U: {@} dBc, Overload is {1}",
MeasuredACPR[3], MeasuredACPROverload[3]);

Console.WriteLine("Repeat? y/n");

response = Console.ReadLine();

}
#endregion
}
catch (Exception ex)
{
Console.WriteLine("Exceptions for the drivers:\n");
Console.WriteLine(ex.Message);
}
finally
{
if (driver != null)
{
// Close the driver
driver.Close();
Console.WriteLine("");
Console.WriteLine("Driver Closed");
}
}
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Console.WriteLine("Done - Press Enter to Exit");

Console.ReadLine();

Get the Measurement Result
Refer to the process of step 7 in example 1 to build and run your program to

get the result as below.

Perform Power Servo, then Measure ACPR
Current SPI Config Value : B8xBDriver Initialized

m|»

Press Enter to Run Test

Measured Power —-14.778536480%7185%dbm .

o Overload is False
L: —27.664347737987 dBc. Overload is False
?.7538420168%41 dBc, Overload is False
H 4.67221828732 dBc, Overload is False
U: —44.97251192748288 dBc. Overload is False

Repeat? w/n

Before running the program, please make sure the M9300A reference software

Servo Count is 6. Serv

Servo pass is True,

Is turned on.
It will take several minutes to run the program as the VXT vector transceiver

need boot up before running this program.
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